
Macintosh DiscPassage

This document contains the following information:

 • System Requirements for running DiscPassage

 • Installing and Using DiscPassage

 • Features

 • Troubleshooting

 • Some commonly encountered problems

System Requirements for the Macintosh

DiscPassage requires:


 • A Macintosh Plus, SE, SE/30, II (any model), Classic, LC,

   or IIsi with CD-ROM drive.


 • 400K of available space on your hard drive.
 

 • System software 6.0.7 or greater, 32 Bit QuickDraw, Foreign File 
  

   Access and ISO 9660 File Access in your System folder and driver 
   

   software for your CD-ROM drive in your System folder. 


   For instance, if you have an AppleCD SC drive, the init is named 
  

   "Apple CD-ROM."  


 • A minimum of 2 MB of RAM (2.5 MB for System 7).
 

 • Color images require a color monitor; they are displayed

   in 640x480 resolution in 256 colors.  You need to have 32-bit
            QuickDraw in your System Folder.  Images automatically convert       
   
            to black and white for the SE, Plus, and Classic. 


 • DiscPassage operates under Finder or Multi-Finder environments,

   as well as System 7.



Installing & Using DiscPassage

To install the DiscPassage application, insert the floppy diskette
(or CD-ROM), and open the Desktop.  Drag the icon labeled "DiscPassage"
to the area on your hard drive where you wish to install it.


 • Launch DiscPassage by getting to the hard drive, then double 
   
   

   click on its icon. 


 • DiscPassage first presents you with a database selection menu

   representing databases on the disc.


 • Selecting a database by double-clicking will display the

   contents for this database.  You can navigate the disc by 
  
   

   searching or browsing from the menu bar or traversing the  
  
  

   hierarchically structured contents windows. 


 • An item with a folder icon to the left of the entry indicates 
     
   

   that there are levels beneath this.  Individual entries which 
  
   

   can be called up directly will be labeled by one of these types 
   

   of icons:  


 T:             text file

 Pict Icon:     image

 audio speaker: audio selection

About DiscPassage

        DiscPassage is a program which provides a menu-driven user 
        interface for accessing the information on your CD-ROM.  
        DiscPassage provides various means of accessing CD-ROM data, 
        including a hierarchical "Contents" menu and "Search" and 
        "Browse" facilities.  In addition, DiscPassage offers facilities 
        for displaying graphic images, printing text and images, playing 
        sounds (if the CD-ROM has audio content) and copying text to 
        user-named files.
        
        DiscPassage will run properly only if there is a DiscPassage 
        CD-ROM in the CD drive.  DiscPassage CD-ROMs have the word 
        "DiscPassage" or the word "CMC" printed on the CD-ROM or the 
        CD-ROM jewel box.



Features

DiscPassage offers powerful search and retrieval features, including:


 • The File menu allows you to Save text and images, Print

   text or images, get comprehensive on-line Help, Eject the        
   

   DiscPassage disc, see which Discs are available, or Quit.


 • The Edit menu provides basic text editing functions including 
  
   

   Cut, Copy, Paste, Clear and Select All.


 • The Format menu on the main menu bar supports various operations

   on text files.  Once a region of text has been highlighted, you 
   

   can change its font, point-size, and style.  Text files are 
     
   

   saved in Microsoft Word format. Format does not affect files on 
   

   the CD.


 • The Related Items menu shows you the entries for images, audio, 
   

   or text files related to the file you are viewing.
  

 • The Search menu lets you perform on-line searching on various

   indexes:  Words, Authors, Titles and Subjects.  

   You may search for phrases, wild cards, proximity and combine  
  
   

   search terms with the AND, OR, or NOT Boolean operators.  See 
    
   

   on-line Help for more information.  Click on the Titles button 
   
   

   to see the titles of the documents matching your search 
   
  
   

   criteria.


 • Browse lists every word of every document on the disc and the

   number of documents that contain the word.  Click on the Titles 
   

   button to see the titles of these documents.  You may cut and 
    
   

   copy a word found in browse to the Search template, and build 
  
   

   phrases this way.


 • The Find menu allows you to search a document for a search or 
  
   

 browse term or any word or phrase you are looking for.



Troubleshooting

Installation of the DiscPassage software should be easy.  Problems may
arise, however, with installation of the CD-ROM unit and its drivers. 
Be sure you have the proper inits in your System folder (they have to
be inside the System folder or they will not get installed at system
startup). 

You need to have the following:


 • System Software 6.0.7 or greater, Foreign File Access and

   ISO 9660 File Access inits


 • An init supporting the type of CD-ROM you have, for example:

   AppleCD-ROM init


 • 32-bit QuickDraw 


 • You should see an icon for the CD-ROM disc on the desktop. If

   you don't, the system is not mounting the drive properly.  Check 
   

   to be sure your SCSI cable is securely connected and there are 
   
   

   not multiple devices assigned to the same SCSI address.  If 
  
   

   trouble persists, check the SCSI termination.

Some commonly encountered problems


 • An Apple CD-ROM drive requires the Apple CD-ROM init

   version 2.0 or greater to properly mount ISO-formatted CD-ROMs.
 

 • If your CD-ROM disc is not mounting on the desktop

   consistently, you may have an init conflict.  Be sure to only

   install the init for the CD-ROM drive you are using, and hide 
   
   

   the others (create a folder inside your System Folder to save 
  
   

   them).


 • Other inits besides drivers may conflict with your CD-ROM

   inits.


 • "The selected index is not available on this Disc"  You must

   be in a text database to access indexes.  Some discs, as well as 
  

   some databases, do not have indexes associated with them.
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        1 - Before You Call Technical Support     

        Creative Multimedia maintains a Technical Support staff to help 
        customers with problems which occur, and to answer questions 
        about our products.

        Before calling for Technical Support, please be sure to read
        this document.  Many of the most common problems can be solved
        using the information provided here.  If you do need technical
        help, please make a note of the version of DiscPassage and the
        title of the CD-ROM(s) which you are using.  Also please note
        any details about your system which might be relevant to the
        problem.  For example, if the problem is that graphics will not
        display properly, the manufacturer and model of your video 
        controller card will be helpful.  Your DOS version number,
        available memory, microprocessor type and whether you are using
        third party memory management, file compression or operating
        system software (for example QEMM, Stacker or DR DOS) all may
        be relevant to problems which occur.

        DiscPassage is licensed for use by various CD-ROM producers.
        If your CD-ROM is the product of a company other than Creative Multimedia,
        please call that company first for technical support.



        1.1 - System Problems

        If the problem you are experiencing is caused by a component of
        your system that is not a Creative Multimedia product, we 
        recommend that you call the manufacturer or vendor of that product 
        for Technical Support.  CD-ROM Drive installation or malfunction, 
        installation of DiscPassage under various menuing or windowing 
        interfaces, and CD-ROM network implementation are some examples.

        
        2 - Printing or Viewing This Document

        There are two ways to print this document.  If you are viewing
        it under DiscPassage, simply press "F7" while the text is 
        displayed.  If you are in DOS, change to the "DiscPass" 
        directory and enter the command "printme".  The document is 
        printed to the default printer.

        To view this document while in DOS, change to the "DiscPass" 
        directory and enter the command "readme".

        3 - About DiscPassage

        DiscPassage is a program which provides a menu-driven user 
        interface for accessing the information on your CD-ROM.  
        DiscPassage provides various means of accessing CD-ROM data, 
        including a hierarchical "Contents" menu and "Search" and 
        "Browse" facilities.  In addition, DiscPassage offers facilities 
        for displaying graphic images, printing text and images, playing 
        sounds (if the CD-ROM has audio content) and copying text to 
        user-named files.
        
        DiscPassage will run properly only if there is a DiscPassage 
        CD-ROM in the CD drive.  DiscPassage CD-ROMs have the word 
        "DiscPassage" or the word "CMC" printed on the CD-ROM or the 
        CD-ROM jewel box.
        
        Once DiscPassage has been installed on your hard drive, you
        can access any DiscPassage CD-ROMs using the command "DP".



        4 - System Requirements

        IBM PC or compatible with MS-DOS version 3.1 or later.

        CD-ROM drive with appropriate drivers.

        Microsoft CD-ROM extensions version 2.0 or later.

        512K available free conventional memory.

        1 Megabyte free space available on hard drive.

        VGA video card and monitor.  Super VGA card with VESA driver
        recommended.

        For CD-ROMs which contain audio content, headphones or amplified
        external speakers which connect to the CD-ROM audio jack or
        external speaker outputs.

        The "files" command in the CONFIG.SYS file should be set to
        at least 20 ("files=20").

        5 - Installing DiscPassage

        Log onto the CD-ROM drive (type the letter of your CD-ROM drive,
        followed by ":", then press "Enter").  Type "setup" and press 
        "Enter".  The setup program will prompt you through the 
        installation procedure.  Setup creates a directory on your hard 
        drive which contains the DiscPassage files.  No changes are made 
        to your AUTOEXEC.BAT or CONFIG.SYS files.

        The DiscPassage Setup program installs two versions of Disc-
        Passage: Version 1.5 and Version 2.0.  This document refers
        primarily to Version 1.5.  Version 2.0 is a major upgrade to
        DiscPassage which is still in the BETA Testing Phase.  See
        Section 9 - DiscPassage Version 2.0 for more information.

        6 - Starting DiscPassage

        Once DiscPassage has been installed, any DiscPassage CD-ROM
        can be accessed by placing the disc into the drive and entering 
        the command "DP" at the DOS prompt.  Any new version of Disc-
        Passage which you install will be compatible with earlier 
        DiscPassage CD-ROMs.



        7 - Using DiscPassage

        After the "DP" command has been entered, a license agreement
        is displayed.  Press enter to accept the agreement.  A title 
        page illustration is displayed.  When you press enter a Database
        Menu is displayed.  The Database Menu lists the main sections
        which are contained in the CD-ROM.  When you select an item from 
        the Database Menu, the DiscPassage Main Menu is displayed.  

        7.1 - Using Help

        The best way to learn about DiscPassage is to use it in 
        conjunction with the help feature.  "Help" is availabe from
        any location in the program, beginning with the opening license
        agreement screen.  To display context-related Help, press the
        "F1" key.  A window on the screen will provide information 
        related to the DiscPassage function currently in use.  "Help" 
        provides much valuable information which can help you learn to 
        use the DiscPassage features more effectively.  The "Search" 
        feature in particular is extensively documented.
        
        7.2 - Using The Main Menu

        DiscPassage displays a menu bar at the top of your screen.
        The menu includes the selections "Search", "Browse",
        "Contents", "Database", "Printer" and "Change/Exit".  
        
        "Search" helps you search the database for specific words, 
        authors, subjects and titles, to identify related documents.  
        
        "Browse" helps you review lists of words, authors, subjects, or 
        titles, then select corresponding documents.  
        
        "Contents" lists the table of contents contained in the database, 
        and allows you to select a document.  
        
        "Database" identifies information available on the CD and helps 
        you select a database.  "Printer" lets you specify a printer type 
        for printing graphic images, and specify a default printer port.  
        
        "Change/Exit" lets you change to another DiscPassage CD-ROM disc 
        or drive letter, or exit DiscPassage.  
        
        Use the right/left arrow keys to highlight different selections.  
        Press "enter" to select the highlighted title.  
        



        7.3 - Using The Function Keys

        While using DiscPassage, the descriptions of any applicable 
        function keys are displayed at the bottom of the screen.  
        Here is a summary of the function keys used in DiscPassage:

        F1 provides on-line Help.  A Help screen which is relevant to 
        the current context is displayed.

        F2 clears the search template so the user can start a new search
        process.

        F3 displays the next text article from a search list, when the 
        user is viewing an article from that list. 
        
        F4 toggles the graphics display between VGA and high
        resolution monochrome when the graphics mode is standard VGA.
        F4 also can be used to jump directly from the opening license
        agreement to the main DiscPassage menu, bypassing the title
        page graphic.

        F7 prints the currently displayed text file or graphic image.
        Before printing images, select "Print" from the main 
        DiscPassage menu to specify "Epson" or "HP Laser Jet".  Your 
        printer must be compatible with one of these two standard 
        printer types in order to print images under DiscPassage.
        
        When printing a graphic, there will be no message on-screen
        while the printing is taking place.  When the printing is 
        successfully completed, three quick beeps (low - high - low) 
        will sound.  If a problem is detected, two beeps (high - low)
        are sounded.  
        
        F8 copies the currently displayed text file to a user-named
        file.

        F9 displays a menu of tables, images or audio selections
        related to the current selection.

        F10 displays the titles found during a search, or moves to the
        next highlighted search term in the text.



        7.4 - Using the Special Function Keys

        "Enter" selects the currently highlighted menu choice.  

        "Escape" exits the current menu, document, image, or audio 
        selection and returns to the previous menu or document.

        "Home" goes to the beginning of the document or top of the menu.

        "Page up" scrolls up one page in the document or one menu screen.

        "Page down" scrolls down one page in the document or one menu
        screen.

        8 - Problem-Solving

        If you experience problems while installing or running
        DiscPassage, the information which follows may be helpful.
        You will also find useful information in your CD-ROM drive 
        manual, the DOS manual or your computer system manual.

        8.1 - CD-ROM Drive Problems

        If you are unable to log onto the CD-ROM drive, just as you
        would a floppy drive (by typing "D:<enter>", for example),
        the CD-ROM drive is not working properly.  Some possible reasons
        are (1) the CD-ROM installation process was not successfully
        completed, (2) the system was not rebooted following the
        CD-ROM installation, (3) the CD-ROM drive was not turned on prior
        to booting the system, (4) the cables have been disconnected
        or damaged or (5) files on your system have been lost or
        changed.  If there is a problem with the CD-ROM Drive, check
        for these possibilities and, if necessary, contact the CD-ROM
        Drive manufacturer for Technical Support.



        8.2 - MSCDEX

        MSCDEX.EXE (Microsoft CD-ROM Extensions) is an extension to
        DOS which allows the system to recognize the CD-ROM drive as
        another disk drive, assigning a drive letter to the CD-ROM.
        MSCDEX.EXE is included in the software supplied with the CD-ROM 
        drive, and is added to the system by running the CD-ROM drive 
        installation program.  If you suspect that MSCDEX has not been 
        properly installed, run the CD-ROM drive install program or 
        contact the CD-ROM drive manufacturer.

        Beginning with version 6.0, MSCDEX.EXE is supplied with MS-DOS.
        If you install DOS 6 or 6.2, you may need to edit the line in your
        Autoexec.Bat file in which MSCDEX is loaded to show the correct
        path name for MSCDEX.  For example:
        C:\CDROM\MSCDEX.EXE .....   would be changed to 
        C:\DOS\MSCDEX.EXE .....
        
        8.3 - Memory Requirements

        DiscPassage requires 500K RAM free to run properly.  Use the
        command "chkdsk" to check the amount of memory which is free.
        The last line in the display shows the amount of free memory
        in your system.  If your system does not have enough free memory,
        consult the DOS manual for help in optimizing your system's
        memory handling and increasing conventional memory.

        
        8.4 - Command Line Options

        Under some cirmumstances it is helpful to enter some extra 
        information when typing "DP" to start DiscPassage.  DiscPassage 
        provides two command line options which can be used to specify 
        (1) the CD-ROM drive letter or (2) a video card type other than 
        the one which is auto-detected.

        8.5 - Specifying the CD-ROM Drive

        DiscPassage will normally select the first available CD-ROM
        drive letter.  If there are multiple CD-ROM drives in the
        system, use the "-d<drive letter>" option to specify the
        drive to be accessed.  For example, a multiple CD-ROM player
        might have six drives, with the letters D through I assigned
        to them.  If the DiscPassage CD-ROM to be accessed is in the
        second drive, then the command to start DiscPassage would be
        "dp -de".



        8.6 - Specifying the Video Card Type

        DiscPassage will try to detect the type of video card in the
        system and supply the appropriate video driver for displaying
        graphic images.  Use the "-v<video card type>" option to
        override the card which is detected and substitute one from
        the list below.  For example, if the graphics are not 
        displaying properly, and the user knew that a Trident video
        card was installed in the system, the command "dp -vtrident"
        would start DiscPassage, overriding the autodetected card,
        and supply instead a video driver for the Trident card.  

        The video card types which can be used as command line options
        are listed below:

          vesa
          tseng           (STB, Orchid, Genoa)
          tseng4          (Orchid)
          paradise        (Western Digital, AST)
          video7          (Video 7, Headland, VRAM, Fastwrite)
          trident
          everex
          ati             (ViewPerfect, ViewSonic)
          chipstech       (Chips and Technologies, Cardinal)
          aheada
          aheadb
          genoa
          zymos
          oak
          tecmar
          stdvga          (standard vga, 360 x 480 x 256 color)
          mode12          (monochrome)
          mode13          (standard vga, 320 x 200 x 256 color)
          textonly        (no graphic display - may help with EGA)

        8.7 - Adding Command Line Options To DP.BAT

        If it is necessary to use a certain command line option each
        time DiscPassage is run, use the DOS EDIT utility to insert
        the option into the DP.BAT file.  Go to the root directory (or 
        whatever directory the file DP.BAT is in.  Enter the command "edit
        dp.bat".  Move the cursor to the line in the file which starts
        with "dpsg.exe".  Move the cursor to the first "%" and insert 
        the exact command line option (such as "-vtrident ").  The line
        will now read, for example, "dpsg.exe -vtrident %1 %2 %3".  Save 
        the file.  Test the change by running DiscPassage.
        



        8.8 - Graphics Display - VGATEST

        If graphics images do not display properly, there are two test
        programs in the DiscPass directory which may help.  To run
        VGATEST, enter the command "vgatest" while in the DiscPass
        directory.  VGATEST displays a message which tells which video
        card type is detected.  If a DiscPassage CD-ROM is in the CD-ROM
        drive, pressing "enter" will display a graphic from that disc.  
        Use the video card command line option (see explanation above) to 
        try out different video graphics drivers.  (The -v option can be 
        used with both the "dp" and the "vgatest" commands.)
        
        8.9 - Graphics Display - VESATEST

        If none of the video drivers in DiscPassage work correctly with 
        your video card, you may want to use a VESA video driver.
        VESA is a standard which has been created for interfacing with
        super VGA video cards.  A Super VGA card may have a VESA driver
        built into the ROM (read only memory) of the video card.  Older 
        cards may require a TSR (terminate and stay resident - a program 
        which, once executed, resides in your computer's memory) driver 
        to be loaded in order to provide VESA support.  This TSR may be 
        found on the distribution disks from the video card manufacturer, 
        or may be obtained directly from the video card vendor or 
        manufacturer.

        To determine if a VESA driver is currently available in your
        system, run VESATEST from the DiscPassage directory.  This
        program will tell you if VESA video extensions are loaded,
        whether or not DiscPassage will use VESA for image display, and
        if not, why DiscPassage will not use VESA.  DiscPassage requires
        that VESA mode 101H is supported in order to display 640 by 480
        by 256 colors.
        
        8.10 - Audio

        Some DiscPassage CD-ROM titles contain audio information.
        The audio from these discs will come through the CD-ROM
        drive's audio outputs.  If your system is equipped with a
        sound card, the DiscPassage CD-ROM audio will not be heard
        through the sound card unless the CD-ROM's audio outputs are
        connected to inputs to the sound card.  Consult the sound
        card vendor for information regarding hardware which may
        be available to make the connection.



        8.11 - Program Crash

        If DiscPassage fails to start properly, exits to DOS
        prematurely or "freezes" your system at some point, there are a 
        number of possible causes to look for.

        The first item to check is free memory (see MEMORY
        REQUIREMENTS above).

        Another possible cause of problems is the interaction between
        DiscPassage and your graphics card. Try running DP with the
        "-vtextonly" option (see COMMAND LINE OPTIONS above).  If the 
        crash no longer occurs, experiment further with the various 
        video card options.

        A third area to check is conflicts between DiscPassage and
        other software already loaded in memory (device drivers or
        TSR programs).  One way to test for such conflicts is to insert
        the word "rem" before each line of the Config.Sys and
        Autoexec.Bat files which installs drivers and TSRs which are
        not needed to run the CD-ROM unit.  The "rem" negates the
        line so that when the system is booted, that line has no effect.
        If DiscPassage then runs properly, the "remmed out" lines can
        be brought back in one at a time, until the conflicting line is
        identified.  Sometimes changing the order that these lines
        appear in the files can eliminate a conflict.

        A common conflict which causes DiscPassage to crash is between
        some mouse drivers and the VESA video driver.  If you press 
        enter to continue from the license agreement and the system
        goes immeditately back to DOS, displaying the CD-ROM drive, or
        if after the first graphic is displayed the system freezes and
        an error message "memory allocation error..." is displayed, 
        there probably is a mouse driver/vesa driver conflict.  Test for 
        this by "remming" out the MOUSE.COM line in the autoexec.bat
        file.  After rebooting the system, run DiscPassage.  If 
        DiscPassage runs properly, the conflict has been identified.  The
        solution is to obtain an updated driver from the manufacturer of
        the mouse, or a different mouse driver.

        



        9 - Installing DiscPassage 1.5 to Run Under Windows 3.1

        To install DiscPassage to run under Windows, first install
        under DOS, as explained under Installing DiscPassage.
        
        While in Windows, set up DiscPassage as an application:  
        From your application window (or any window of your choice) 
        select FILE from the program manager menu, then select NEW.  
        Click on the circle next to ADD A PROGRAM ITEM, then click OK.

        In the box which appears, enter the following properties:
        Description:       DiscPassage
        Command line:      C:\DP.BAT
        Working directory: C:\DISCPASS
        Select an icon for the application, then click OK.

        Next, a PIF FILE needs to be created.  From the MAIN window, 
        select PIF Editor.  From the menu, select FILE/NEW.  Enter the 
        following settings:
        Program filename:  DP.BAT
        Window title:      DiscPassage
        Startup directory: C:\.
        Video memory:      text
        KB required:       536K
        Display usage:     full screen
        Execution:         exclusive
        (No advanced settings).
        Otherwise, leave the default settings as they are.  Select 
        FILE/SAVE AS and enter the name of the file as DP.PIF.  Save 
        changes and exit the PIF Editor.

        The path names used in this example assume you used the default 
        DiscPassage setup.  If you did not take the default DiscPassage 
        directories, your directory names here will need to reflect that.

        DiscPassage should run properly under Windows using these 
        settings.  For more information about PIF files and running DOS 
        applications under Windows, consult your Windows manual.  Some
        systems may not support DiscPassage in the Windows environment.
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